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PART ONE—INSTALLING FOREX AUTOSCALER V.4.0 INTO YOUR MT4 PLATFORM

Follow these steps to copy and paste AutoScaler into your platform.
1. Open your platform and click on the File tab in the upper left hand corner.

2. Scroll down to the “Open Data Folders” option in the window which opened. Click on this option to
open a new window.

3. In the new window that opens, locate and double click on the MQL4 folder to open it. Alternatively
you can right click on the MQL4 folder and select Open to open the folder.

4. Inside the MQL4 folder locate and open the Experts folder.

5. Copy and paste ForexAutoScaler v.4.0.ex4 into this Experts folder.

6. Now close all the open windows.

7. Reopen the platform and click on the View tab in the upper left hand corner.

8. Select Navigator from the open window to open the Navigator window.

9. Inside the Navigator window locate the Experts folder and click on it to openiit.

9a. Right click your mouse inside the Experts area and select Refresh. This will complete the loading
process to add AutoScaler into your platform

10. Locate the ForexAutoScaler_v.4.0 file and left click on the file, holding the left mouse button down,
and drag the file onto your chart.

11. Make sure there are checkmarks next to Allow Live Trading, Enable Alerts, and Allow DLL imports
under the Common tab.

12. Adjust the various settings under the Inputs tab according to your preferences.
13. Now click the OK button along the bottom right portion of the AutoScaler window.

14. Make sure the AutoTrading button along the top of the platform is on (green light = on, red light =
off). If the light is red, click on the AutoTrading box once to turn this function on.

15. Check the left hand corner of the chart where you loaded the AutoScaler EA. If you see a Smiley
Face, then the EA has been loaded properly and is now ready to use.

16. If you don’t see a smiley face, go back through every single one of these steps to make sure you
installed and loaded the EA according to the instructions.

17. If you performed the install correctly but still do not see the Smiley Face, click on the Tools tab along
the top of your platform and select Options.

18. Inside the Options window, click on the Expert Advisors tab and make sure there is a check mark in
the boxes next to Allow automated trading and Allow DLL imports.

19. You should see the Smiley face now. If not, contact me at jeffglenellis@gmail.com and | will
schedule a remote viewing session to see if we can spot where the errorlies.
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PART TWO—ADIJUSTING THE SETTINGS FOR FOREX AUTOSCALER V.4.0

After you install Forex AutoScaler onto an MT4 chart, when you click on the Inputs tab you will see these
settings:

Expert - AutoScaler_v4.0 ? e

About Common Inputs

Wariable Value

s« FIFO (follow trades ) false

23 MagicNumber 123456

¥ Initial Lot 0.1

Y& Lot Multiplier 20

123 Additional Trades 10

23 Pips Interval 10

s« Follow Manual Trade TP false

#= Follow Manual Trade SL false

Y& TakeProfit( manual ) 0.0

Y& Stoploss ( manual) 0.0

Y& TakeProfit{ grid) 0.0

e Stoploss ( grid) 0.0

Y&~ SL Risk % ( manual) 0.0

Y& TrailingStop 0.0

e Slippage 20

Y& Incremental SL 5.0

¥e Incremental SL Step 5.0

23 Display Comer Right upper chart corner Load
Save

Cancel Reset

Here is a list and detailed explanation for what each of these settings does within the AutoScaler EA.
Please study this carefully because some of the settings must remain set at 0.0 when other settings carry
a positive number.

1. FIFO: A function we tried to include to allow US based OANDA traders to use AutoScaler.
Unfortunately, we were not able to get this function to operate as OANDA kept changing the rules
and we finally gave up. Leave this set to “false” and we will be removing it in future updates.

2. MagicNumber: Required by the programming language, each EA will have its own Magic Number.
Leave this setting alone. You will never have any reason to change it.

3. Lot: Here is where you set Lot Sizes for your AutoScaler Trades (and your Manual Trade should you
use the buttons which are now on your chart in the upper right hand corner). 1.0=1Full Lot. 0.1 =1
Mini Lot. 0.01 = 1 Micro Lot. Check with your broker to see that they allow Micro Lots. Some do, some
don’t. If you set this option as a Micro Lot and your broker does not allow Micro Lot trading, AutoScaler




will not set up any trades for you.

4. Lot Multiplier: This function will increase the Lot Size of your pending trades by whatever amount
you set. | STRONGLY RECOMMEND YOU SET THIS AT 1 UNTIL YOU ARE COMFORTABLE USING
AUTOSCALER. Leaving it set to 2 will cause your lot size to double for each pending trade you place. So
a single minilot manual trade would result in a 2 minilot first pending trade, a 4 minilot second pending
trade, an 8 minilot third pending trade, and so on. You can quickly eat up all your available margin
funds if you leave the setting at 2. So change it to 1 for now.

5. AdditionalTrades: You can scale in anywhere from 1 to 30 additional trades on top of the manual
trade you must take in order for AutoScaler to work. However many trades you want, type in that
number (30 is the maximum, though). HOWEVER, if you want to set up trades in both directions
(hedging) you can do so in segments of 10, as long as your broker allows hedging (sorry USA, none

of your brokers allow that).

6. Pipsinterval: This is how many pips apart each pending AutoScaler trade will be set up. If you want 5
pips between trades, type in 5. If you want 10, type in 10. If you are trading Gold, pips are worth 10
cents apiece (a $1 move in the price of gold equals 10 pips). So if you want a 5 pip space between
trades, you need to type in 50. A 10 pip gap would require a setting of 100. If you are trading Indices
such as the US30 or NAS or S&P, you will need to add two zeros to your desired box size, using S1
increments. In other words, if you want to space your trades $5 apart, you would use a setting of 500.

7. FollowManualTradeTP and FollowManualTradeSL: TP stands for Take Profit, SL stands for Stop Loss.
Both of these options work exactly the same way. If you want to set a specific price for your Manually
placed trade to exit at either or both the TP and SL, AND you want all of your pending AutoScaler trades
to exit at the exact same price, you need to switch the settings on these two options to True. Double
click on the window next to TP and/or SL to activate the window. Click on the downward facing arrow in
the right corner of the window to open a drop-down box. Click on True to activate this option, click on
False to terminate this option.

8. TakeProfit(manual) and StopLoss(manual): Both of these options work the same way. If you want to
automatically set a Take Profit price and/or a Stop Loss price on your manually placed trade without
needing to go back into the MT4 system and manually set these options, simply type in the number of
pips you want for a Take Profit and/or a Stop Loss. If you want a 20 pip TP or SL, type in 20. If you want
a 100 pip TP and/or SL, type in 100. This will automatically place the TP and/or SL on your manual trade.
NOTE: If you set the Follow Manual Trade TP or SL settings to true, then the price point equal to the pip
value you set here will be used for all your AutoScaler trades. So if you set a TP to 20 and when you
place your manual trade, price is at 1.2000, it will set your manual TP at 1.2020 AND set the same TP
price for all your AutoScaler trades. (The same rules for trading Gold and trading Indices applies. You
will need to add 1 zero [gold] or 2 zeros [Indices] to see the results you seek in pricing your SL and/or
TP). NOTE: If you adjust these two settings to a positive integer, you must leave the (grid) settings,
below, set to ZERO.

9. TakeProfit(grid) and StopLoss(grid): If you want to set a fixed number of pips for your Take Profit
and/or Stop Loss on all your pending AutoScaler trades, type in that pip number here. If you want a 20
pip TP on all your AutoScaled trades, type in 20 in the TakeProfit(grid) line. If you want a 20 pip SL, type
in 20 in the section next to StopLoss(grid). Note: If you use either or both of these options, youmust
leave the corresponding FollowManualTrade option set to False. If you set the Follow option to True
and then set a positive number for the Grid, it creates a conflict within the EA and it will not function. So
either use the Follow option or the Grid option for TP and SL, but not both. (Same rules apply to Gold
and Indices as noted above). NOTE: If you adjust these two settings to a positive integer, you must



leave the (manual) settings, above, set to ZERO.

10.  SL Risk%: For those of you who want to use a Stop Loss equal to x% of your account, use this
option and leave the FollowManualTradeSL option false and the StopLoss(manual) and StopLoss(grid)
option set at 0.0. For a full percentage point value, such a 2%, simply type in 2.0. For a portion of a
single percent, such as half, or one quarter, type that in as well as follows: %% = .25; %% = .50; %%=.75;
1% = 1.0; and so on.

11. Trailing Stop: As advertised, this is a trailing stop function. Type in whatever pip number you
want to use as a trailing stop and the EA will turn the trail on once price reaches that figure. It will use
your preset SL amount from either (manual) or (grid) as the starting point for the trail.

12. Slippage: This sets up the amount of pips you are willing to sacrifice to get into a trade if entry
cannot be made at your specified price point. | strongly suggest you leave it at 2 unless you have a very
good reason to change it.

13. Incremental SL. This is the overall size of your desired stop loss. | use a 12 pip stop on most of my
trades, so for FX the stop is 12, for Gold 120 and for Indices 1200. IMPORTANT: You MUST set the
StopLoss(Manual) setting to the same number when using the Incremental SL. If you do not want to
use the Incremental SL, set it to Zero.

14. Incremental SL Step: The amount the Stop Loss will move each time the Step Stop is activated. In
most of my trading | use a 5 pip step, so my setting for FX is 5, for Gold 50 and for Indices 500. If you
do not want to use this feature, set it to Zero.

15. Display Corner: This is how you move the Buy/Sell buttons around. You can adjust them to appear
in any of the four corners of the chart: Upper Left, Upper Right, Lower Left or Lower Right,

To see all of these options demonstrated live, view the accompanying videos found on the download
page.

Once you have adjusted the Inputs to your liking, click the OK button and AutoScaler will load onto your
chart and be available for your next trade.

TROUBLESHOOTING

If you followed all the steps as outlined above and AutoScaler does not place any additional trades once
your manual trade is accepted by your platform/broker, her are the most common reasons why and how
to fix them.

1. Open the Inputs window and look under the common tab to make sure Enable Alerts, Allow Live Trading,
and Allow DLL imports all have check-marks next to them.

2. Make sure the AutoTrading button along the top of your toolbar is On. If so it should look like this:

@@ AutoTrading

3. Make certain you have enough funds in your account to cover the margin costs for all your trades. This
includes Demo accounts as well. If you do not have enough funds to cover the trades, your platform will



reject the trades. The simplest fix is to reduce your trade size from Full Lot (1.0) to Mini Lots (0.1) or from
Mini Lots to Micro Lots (0.01).

4. Make sure your Pipsinterval setting is not too small. Some broker reject trades if they are placed within
1 or 2 pips of the previous trade. Experiment with your broker’s platform to see if you are limited in this
way. Or stick with a minimum of 3 pips for this setting. I've never heard of a broker rejecting trades 3 pips
apart for being too close.

5. If you have AutoScaler loaded onto 2 or more charts for the same pair/trading vehicle, this will cause
chaos within your platform and you will not get the results you are looking for. So do not load AutoScaler
onto a 1M and a 5M chart for the same pair or Indices/Gold chart. Only load it once.

6. If you are a Renko trader, we can no longer run AutoScaler on Renko charts. Load it onto a timed chart
and take your trades from there. The lines will all still appear on your Renko chart but recent changes to
the MT4 platform have stopped AutoScaler from working on Renko. We will keep monitoring the situation
and alert everyone if/when that changes.

7. Occasionally someone comes up with a new and unique way to screw up the works, and when this
happens, and none of the previous Troubleshooting steps apply, open the Terminal Window and click on
the Experts tab along the bottom of Terminal. You should see an Error Code number next to the aborted
AutoScaler trade. Look the number up using a Google search “What does MT4 Error Code --- mean” where
“---"is replaced by the actual Error Code. You’ll find an answer. If not, send the Error Code number to me
at jeffglenellis@gmail.com and | will sort it out for you.
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PART THREE-USING THE CHART BUTTONS

After you load AutoScaler successfully on a chart, this is what you should see:
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AutoScaler V4.0 automatically installs a series of buttons on your chart allowing you to enter and exit
your trades in a batch without needing to go through the MT4 Terminal window.

When you are ready to place a Buy trade, simply click the Green BUY button and a manual Buy trade in
the lot size you designated in the EA settings will be placed.

When you are ready to place a Sell trade simply click on the Red SELL button and a manual Sell trade in
the lot size you designated in the EA settings will be placed.

If you reach a point where you want to close ALL of your open and pending Buy trades click on the
Close Buy button.

Similarly, if you are ready to close all your open and pending Sell trades, click on the Close Sell
button.

Lastly, if you are in a trade or series if trades in one direction and you want to close all those trades and
immediately place trades in the opposite direction, click on the Reverse button.




PART FOUR—RANDOM THOUGHTS ON USING AUTOSCALER

If you’ve done any trading during the time when major economic news is released (what we call red
folder reports using the Forex Factory Calendar scoring system) then you probably noticed that most, if
not all brokers are widening the spreads on pretty much all pairs right before the scheduled release
time. This can wreak absolute havoc on AutoScaler trades, particularly Buy trades, as the Ask price can
be moved 20-30 pips away from the Bid price and trigger multiple pending Buy trades simply because
they were in place just before a news release. Often times price will then return back to the original Ask
price and leave you seriously upside down on some or all of your trades. The moral of this story is: DO
NOT USE AUTOSCALER PRIOR TO ANY MAJOR ECONOMIC NEWS RELEASES OR YOU WILL IN ALL
LIKELIHOOD LOSE MOST OR ALL OF THE MONEY IN YOUR ACCOUNT. Yes, | was screaming that. |
wanted to get your attention. Hopefully it worked. Proceed with caution.

If you have a trading EA you want to run in conjunction with AutoScaler, well, bad news. You can’t.
AutoScaler will only accept manual trades that originate from either the Chart Buttons or from the
Pending Order system built into the MT4 platform. It will not accept orders that originate from another
EA. Thisis an MT4 issue, not a coding issue, at least according to my coder.

With some brokers, AutoScaler will accept the trades, both original and pending, and they will appear in
the Terminal window, but you will not see any SL or TP settings on the Pending trades. Do not panic. If
you followed the directions in setting up the trades, once the first Pending trade executes, your platform
will then fill in all the missing SL and TP entries for all pending trades. | have no idea why some do and
some don’t, but give the trade time to execute that first pending trade before you email me.

If you are having any issues with AutoScaler, or you have any ideas for new features you think might
enhance the AutoScaler trading experience, drop em a line at jeffglenellis@gmail.com and | will get back
to you as soon as | am able, typically on the same day or within 24 hours.
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